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2 ARB800 Series Switch Router
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This Hardware Reference includes information on the following models:
= ARS816F-FX/MT-R]

= ARS816F-FX/SC

= ARS824

The latest Hardware Reference can be found at www.alliedtelesyn.co.nz/
support/ar800.

Why You Should Read This Reference

This Reference has been developed to familiarise you with the AR800 Series
and its hardware features. The information found in this Reference will assist
you with the process of installing and maintaining your AR800 Series Switch.

The Reference also introduces Uplink Module, Network Service Module
(NSM) and Port Interface Card (PIC) expansion options. Detailed information
on these options can be found in the Uplink Module Hardware Reference, the
Network Service Module Hardware Reference, and the Port Interface Card Hardware
Reference. These documents are included on the AR800 Series Documentation
and Tools CD-ROM bundled with your switch, or can be downloaded from
www.alliedtelesyn.co.nz/support/AR800/.

Keep this Reference (or its CD-ROM) in a safe place, you will need it if you purchase
switch expansion options in the future.

2

2

This Reference does not cover software configuration or software installation

S
procedures. For information on software, refer to the AR800 Series Switching Router
Software Reference.
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Where To Find More Information

The Documentation and Tools CD-ROM bundled with each AR800 Series
Switch contains the complete Document Set for AR800 Switches and their
expansion options, as well as tools for managing the switch. This includes:

m  The ARS800 Series Modular Switching Router Safety Booklet, which provides
safety and statutory information.

m  The ARS800 Series Modular Switching Router Quick Install Guide, which
outlines the procedure for installing switch units; and this AR800 Series
Modular Switching Router Hardware Reference.

m  The ARS800 Series Switching Router Software Reference, which provides
detailed information on configuring the switch and its software.

m  The ARS800 Series Modular Switching Router User Guide, which provides an
introduction to the switch’s Graphical User Interface and its Layer 2
switching features.

m  The Network Service Module Quick Install Guide, which outlines the
procedure for installing an NSM; and the Network Service Module Hardware
Reference, which provides detailed information on NSMs.

m  The Port Interface Card Quick Install Guide, which outlines the procedure for
installing PICs; and the Port Interface Card Hardware Reference, which
provides detailed information on PICs.

m  The Uplink Module Quick Install Guide, which outlines the procedure for
installing an Uplink Module; and the Uplink Module Hardware Reference,
which provides detailed information on Uplink Modules.

m  AT-TFIP Server for Windows, for downloading software releases.
m  Adobe Acrobat Reader, for viewing online documentation.

m  Netscape Communicator.

m  Microsoft Internet Explorer.

These documents can also downloaded from the AR800 Series Support Site at
www.alliedtelesyn.co.nz/support/ar800/.

Hardware Description

This section provides an overview of hardware features for the AR800 Switch
series. Hardware descriptions for Uplink Modules, NSMs, and PICs can be
found in their respective hardware references. These references can be found
on the CD-ROM bundled with your switch, or can be downloaded from
www.alliedtelesyn.co.nz/support/ar800/.

Switch Overview

ARB800 Switches combine wire speed Layer 2 and 3 switching with full
multiprotocol routing capabilities to deliver low-latency high-bandwidth
traffic capabilities to the desktop. Ethernet, fast Ethernet and gigabit Ethernet
connectivity with both copper and fibre optic interfaces make the AR800 Series
a versatile and powerful switching solution.
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Dimensions
¢ Height = 66 mm (plus 5.5 mm if the rubber feet are used)
¢ Width =440 mm (excluding rack-mounting brackets)
*  Depth =360 mm (including NSM face-plate)
*  Weight = 6.1 kg (excluding NSMs, PICs, and power cord)

Mounting System

¢ 15U rack mounting

Environmental Conditions
* Operating temperature range: 0 to 40° C (32 to 104° F)
e Storage temperature range: -25 to 70° C (-13 to 158° F)

¢ Relative humidity range: 5 to 95% non-condensing

Regulatory Standards
e EMC: CISPR22 class A, FCC class A, and VCCI class I

¢ Immunity testing to EN50082 levels 2 (ESD), 3 (susceptibility), 4 (fast
transients), 5 (power surge), and 6 (RF immunity)

e Safety: UL1950, CSA22.2, EN60950

¢ Ethernet port and System status LEDs
* For a complete list of LEDs and their functions, see “LEDs and What
They Mean” on page 20.
Power Supply Unit
AC models
e Universal 110/240 VAC 50/60 Hz input
e Redundant DC Power connection
DC models
e 48V DC (39-60 V DC is acceptable)

* Accepts positive or negative earthing (grounding)

Switching Core
* Application-Specific Integrated Circuit (ASIC) switch chip
* Non-blocking L2 and L3 IP Switching

Processing Core
e 200 MHz RISC Processor
¢ 32 MBytes Synchronous DRAM
* 6 Mbytes flash memory
e 128 KBytes Non-volatile Storage (battery backed SRAM)

C613-03025-00 REV B
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Asynchronous Seria Port
e Up to 115 kbps
e Standard DB9 female RS-232 connector

e Hardware-flow control

PCI Accelerator Card (PAC) Slot

¢ For an optional 32-bit PCI based hardware Encryption and
Compression Card

Uplink Module Bays
* 2very high performance bays

* Support for gigabit Ethernet Uplink Modules

Network Service Module (NSM) Bay
* Support for one 32-bit PCI based WAN module

* Modules will include hot swap capability with future software releases

AR800 Switch Models

This section provides hardware descriptions for individual switch models.

AR816F-FX/MT-RJ

(Figure 1 on page 5)
¢ 16-port 100BASE-FX (MT-R] fibre connectors)
* Two 1000BASE expansion bays

*  One Network Service Module bay (with support for various WAN

interface cards)

¢ Layer 3 Managed Switch

Figure 1: Front panel of the AR816F/MT.

C613-03025-00 REV B
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AR816F-FX/SC

(Figure 2 on page 6)
e 16-port 100BASE-FX (SC fibre connectors)
* Two 1000BASE expansion bays

*  One Network Service Module bay (with support for various WAN
interface cards)

* Layer 3 Managed Switch

Figure 2: Front panel of the AR816F/SC.

AR824

(Figure 3 on page 6)
* 24-port 10BASE-T/100BASE-TX (RJ-45 connectors)
e Two 1000BASE Uplink Module bays

*  One Network Service Module bay (with support for various WAN
interface cards)

* Auto-negotiating Layer 3 Managed Switch

Figure 3: Front and rear panels of the AR824 (AC model).

Front panel

Uplink Module Bays 10/100 BASE Ports Port LEDs System
LEDs

RS-232 Terminal Port
Rear panel

l—NSM 0—

Swap ®
nusce @ Hotswep

st |

100-240 VAC RPS Inlet for NSM BAY NSM Hot Swap
Power Inlet AT-PWR8000 Button and LEDs

C613-03025-00 REV B



Hardware Reference

o

C613-03025-00 REV B

s

Online Documentation

This section provides a step-by-step guide to accessing online documentation.

Adobe Acrobat Reader must be installed to view the online documentation.

To Access Online Documentation

To use the CD-ROM, follow these steps:

1.

2.

Insert the AR800 Documentation and Tools CD-ROM in the CD-ROM drive.

If the Welcome screen does not appear.
Select "Run" from the Start Menu (Windows 95, 98, 2000 or NT 4.0).
Type d:\start.exe (where d: is the CD-ROM drive letter) and click OK.

To view a document.

Click on the document title.

To navigate around PDF documents.

Use the toolbar buttons, keyboard shortcuts, or commands from the
Document menu to page through the document.

Click on a bookmark, thumbnail or hypertext link to jump to a specific
section or topic.

Use the Search command to search for keywords or phrases.

For more information about using the Adobe Acrobat Reader, select
"Reader Guide" from the Help menu.

To install any of the tools included on the CD-ROM.

Click on a link in the Welcome screen.

AT-TFTP Server

This section provides information on how to access and use AT-TFIP Server.
AT-TFTP Server can be used to transfer configuration files as well as to
download software patches and releases.

3’ To use AT-TFTP Server, follow these steps:
&

V

2

1.

If AT-TFTP Server has not yet been installed.

Install it now from the AR800 Series Documentation and Tools CD-ROM.
Choose AT-TFTP Server from the Start > Programs > Allied Telesyn > AT-

TFTP Server menu.

To set preferences for the AT-TFTP Server.

Select "Options" from the File menu to display the "Set Preferences” dialog

box.
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The "Default file transfer directory” field specifies the directory that AT-
TFIP Server will read from or write to for file requests that do not include a
directory specification.

To prevent unauthorised access to private directories, enter a path name in
the "Restrict to directory” field. AT-TFIP Server will use only the specified
directory, even if file requests contain references to other directories.

Select "Read only" to prevent files being written to the PC. To use the PC to
archive scripts created using the AR800's CREATE CONFIG command,
select "Read Write".

Make any required changes and click "OK".

Set Preferences

A default directory for the TFTP daemon to read and write files from
can be specified. File requests without a directory specification will
uze thiz directory.

Default file transfer directory

c:\wpload
To aid ity. file can be restricted to one directory.
Restrict to directory
|c:\upload

The TFTP daemon can be zet to read only or read and write. In read
only mode. file write requests to your system will be rejected.

V¥ Read Only " Read White

To see extra di. ti click the trol below on

[V Diagnotic Messages

/ oK xﬁancel ? Help

3. To load a file from AT-TFTP Server to the Switch.

On a terminal connected to the switch, type the command:

LOAD METHCOD=TFTP FI LE=fi [ enanme SERVER=/ padd DEST=FLASH

where filename is the name of the file to download and ipadd is the IP
address of the PC running AT-TFTP Server.

4. To save a TFTP Server log.

Select "Save As" from the File menu.

TFTP requests are logged to the AT-TFIP Server main window.

Switch Start-up

This section outlines the log in and start-up procedures for your switch.
Although the switch will perform basic switching operations without being
configured, you will need to go through these log in and start-up procedures if
you wish to configure the switch and access its full layer 3 switching

capabilities.

C613-03025-00 REV B
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To log In

Using the supplied RS-232 DB9 straight-through cable, connect your
terminal or PC to the RS-232 Terminal Port on the switch’s front panel.

Set the communication parameters on your terminal or terminal emulation
program to:

e Baud rate: 9600

e Data bits: 8

e Parity: None

e Stop bits: 1

e Flow control: Hardware

See “Using Windows Terminal and Windows Hyperterminal” on page 31
for more information on configuring emulation software.

After the switch has booted, the log in prompt appears. If the log in prompt
doesn’t appear, press [Enter] two or three times.

When the switch boots for the first time it automatically creates an account
with manager privileges. The account has the log in name “manager” and
the password is “friend”.

At the log in prompt, enter the log in name and password.
Log in: nanager
Password: friend

The switch’s command prompt appears and you can now configure the
switch using the command line interface.

Change the password as soon as possible. Leaving the manager account with
the default password is a serious security risk. Make sure that you remember
the new password as there is no way to retrieve it if it is lost.

Use the following command to change the account password:
set password

To display a list of help topics, enter:
hel p

To display help on a specific topic, enter:
hel p topic

Alternatively, type a question mark (?) at the end of a partially completed
command to see a list of valid options.

See the AR800 Series Switching Router Software Reference for more
information on configuring the switch.

Start-up Procedures

When the switch starts up following either a power cycle or an operator-
initiated reboot (using the Reset button or RESTART command), a series of
start-up messages is sent to the RS-232 Terminal Port (Figure 4 on page 10).
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Figure 4: Switch start-up messages.

INFO Self tests beginning.

I NFO RAM test beginning.

PASS: RAM test, 32768k bytes found.
I NFO. BBR tests begi nning.

PASS: BBR test, 128k bytes found.
INFO Self tests conplete

I NFO. Downl oadi ng swi tch software.
Force EPROM downl oad (Y) ?

INFO Initial downl oad succeeded

I NFO. Executing configuration script <boot.cfg>
INFO Switch startup conplete

Manager >

After the self tests are complete, the manager is given the option of forcing a
mandatory boot from the EPROM release. The message:

For ce EPROM downl oad (Y)?

is displayed on the terminal connected to the RS-232 Terminal Port and the
switch pauses. If a key is not pressed within a few seconds, the start-up process
will continue and all steps in the sequence will be executed. Pressing selected
keys on the terminal immediately after the “Force EPROM download” message
is displayed will change the switch start-up process (Table 1 on page 10).

Table 1: Switch start-up sequence keystrokes.

Pressing key... Forces the switch to...

Y] Load the EPROM release, with no patch.
[S] Start with the default configuration. Any boot script is ignored.
[Ctrl/D] Enter diagnostics mode.

During the start-up process the switch will generate four different types of
messages. All messages are preceded by one of the words INFO, PASS, FAIL,
or ERROR. The significance of these words is shown in Table 2 on page 10.

Table 2: Switch start-up message classes.

Message Meaning

INFO An action will be taken by the system.

PASS A test has been completed successfully.

ERROR An error message that a test has failed, but the system will continue to
operate.

FAIL An error message that a fatal error condition has caused the system to

halt in an unrecoverable fashion.

The possible messages and their meanings are:

INFO. Self tests beginning.
The code loader tests are about to begin.

I NFO. RAM t est begi nni ng.
The RAM tests are about to begin.

C613-03025-00 REV B
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PASS: RAM test, 32768k bytes found.
The RAM test passed, and the indicated amount of memory was found
and will be used in the switch.

ERROR RAMtest 5. Error address = 00345678.
A RAM test failed, at the given address. In the example, it was the fifth
test run. The RAM test repeats until it passes, so a number of messages
like this may appear. This fault means that the memory system is faulty.
If the fault continues, contact your Authorised Allied Telesyn
distributor or reseller immediately.

I NFO. BBR tests begi nning.
The BBR battery tests are about to begin.

PASS: BBR test. Battery OK
The BBR battery tests passed.

ERROR: BBR Battery | ow.
The BBR battery test failed, indicating that the battery is running low.
The BBR battery will need to be replaced. Contact your Authorised
Allied Telesyn distributor or reseller.

PASS: BBR test, 256k bytes found.
The BBR size/location test passed, with the indicated amount of BBR
found.

FAIL: BBR test. Error address = 12345678.
The BBR size/location test failed at the given location. The test at this
location failed, indicating the end of memory, but a valid location was
discovered in the 255 long words following this location. The BBR
system will need to be replaced. Contact your Authorised Allied
Telesyn distributor or reseller.

FAIL: BBR test, only 16k bytes found.
The BBR size/location test completed, but only the displayed amount
of memory was found. This amount is less than the minimum required
to run the switch software.

INFO Self tests conplete.
The start-up tests have finished.

I NFO. Downl oadi ng router software.
The process of downloading the switch software and vector table from
ROM is about to begin.

ERROR: Code |l oad retried.

FAI'L: Code | oad fail ed.
The load of the code from ROM to RAM failed. The load is retried a
number of times. Each time a failure occurs, the ERROR message is
displayed. If the maximum number of attempts is reached, the FAIL
message is displayed.

INFO Initial download succeeded.
The start-up tests and download are complete, and the switch software
is about to be started. If the default install is a compressed release, the
release will now be decompressed. This may take a few seconds.

I NFO. Downl oadi ng conpressed rel ease. This may take up to 1
mnute. ..

I NFO Loading software into nmenory. This may take up to 1
mnute. ..
The main switch software is about to be loaded into RAM. If the release
is a compressed release, the release will be decompressed.
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I NFO. Executing configuration script <script-nanme>
The configuration commands stored in <script-name> are being
executed. If an error is found in the script, one or more ERROR
messages will be displayed.

INFO. Switch startup conplete.

The start-up process is complete and the switch will now perform basic
switching operations. Further configuration will be necessary if you wish to
access the switch’s full layer 3 switching capabilities. See the AR800 Series
Switching Router Software Reference for detailed information on configuring the
switch.

Interfaces

This section provides pin assignments for the switch’s RS-232 Terminal Port
and RJ-45 ports, and the Redundant Power Supply (RPS) connector.

If you have installed a Port Interface Card (PIC), pin assignments for these can
be found in the Port Interface Card Hardware Reference (which is included on the
ARB800 Series Documentation and Tools CD-ROM bundled with your switch,
or can be downloaded from www.alliedtelesyn.co.nz/support/ar800/).

RS-232 Terminal Port

The RS-232 Terminal Port is used to connect the switch to a management
device. For management purposes, the switch’s software can be accessed from
a terminal, a PC running terminal emulation software, or from a remote
location via a modem connection. You can also use the RS-232 Terminal Port to
establish a network connection from a remote site using SLIP and a modem.

The switch’s RS-232 Terminal Port has a DCE female socket. This allows the use
of a straight-through cable when connecting the switch to a terminal or PC.
Output from the SHOW ASYN command will, however, still have a DTE
perspective. The internal DTE pin roles are listed in Table 3 on page 13.

See Terminal and Modem Cables on page 16 for more information on
connection options for the RS-232 Terminal Port.

Figure 5: RS-232 Terminal Port Pin Numbers.

Pin 9 Pin 6
DB9 Female Pin View

C613-03025-00 REV B
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Table 3: Internal DTE pin roles.

Pin Role
2 TXD
3 RXD
4 CD

5 GND
6 DTR
7 cTs
8 RTS

Switch RJ-45 Ports

Caution. Do not plug a phone jack into any RJ-45 port. Doing so could damage
the switch. Use only twisted pair cables with RJ-45 connectors.

For 10BASE-T/100BASE-TX connections, a twisted pair cable must be used.
Each pair is identified by two different colours. For example, one wire might be
red, and the other red with a white stripe. An RJ-45 connector must be fitted to
both ends of the cable. Figure 6 on page 13 illustrates the pin layout for RJ-45
connectors.

Figure 6: RJ-45 Pin layout.

With 10BASE-T/100BASE-TX cables, pins 1 and 2 are used for transmitting
data, while pins 3 and 6 are used for receiving data. Table 4 on page 13 lists the
RJ-45 Pin assignments.

Table 4: RJ-45 Pin assignments.

Pin Number Assignment‘I
1 TX+

2 TX-

3 RX+

6 RX-

1. The “+" and “-" signs represent the polarity of the wires that make up each wire pair.

If a twisted pair cable is to join two ports and only one of the ports has an
internal crossover, the two pairs must be straight through, as listed in Table 5
on page 14.
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Table 5: RJ-45 Pin assignments, straight through cable.

End 1 End 2

1 (TX+) 1 (TX+)
2 (TX-) 2 (TX-)
3 (RX+) 3 (RX+)
6 (RX-) 6 (RX-)

If a twisted pair cable is used to join two ports and either both ports are
labelled with an “X” or neither port is labelled with an “X”, a crossover must be
included in the wiring. Table 6 on page 14 lists the RJ-45 crossover wiring pin
assignments.

Table 6: RJ-45 Pin assignments, crossover cable.

End 1 End 2

1 (TX+) 3 (TX+)
2 (TX-) 6 (TX-)
3 (RX+) 1 (RX+)
6 (RX-) 2 (RX-)

For 1000BASE-T R]-45 cables, all four pairs are used and the cable is wired in a
straight-through configuration. Table 7 on page 14 lists the pin assignments.

Table 7: Pin assignments, 1000BASE-T RJ-45 cable.

End 1 End 2

1 Pair 1+ 1 Pair 1+
2 Pair 1- 2 Pair 1-
3 Pair 2+ 3 Pair 2+
6 Pair 2- 6 Pair 2-
4 Pair 3+ 4 Pair 3+
5 Pair 3- 5 Pair 3-
7 Pair 4+ 7 Pair 4+
8 Pair 4- 8 Pair 4-

C613-03025-00 REV B
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Redundant Power Supply

AC models of the AR800 Series Switching Router have a Redundant Power
Supply (RPS) connector on their rear panel. Table 8 on page 15 lists the
connector’s pin numbers and pin functions.

Table 8: RPS Connector Pin Numbers and Functions.

Pin Number Function

1 +12V DC

2 Remote Sense (RS) +5V DC

3 Remote Sense (RS) Ground

4 Remote Sense (RS) +3.3V DC
5 Redundant Power Supply (RPS) Present
6 Ground (+3.3V DC Return)
7 Ground (+5V DC Return)

8 +5V DC

9 Ground (+12V DC Return)
10 +3.3V DC

11 Ground (+3.3V DC Return)
12 +3.3V DC

13 Ground (+3.3V DC Return)
14 +3.3V DC

15 +5V DC

16 Ground (+5V DC Return)

Table 9 on page 15 illustrates the connector’s pin layout.

Table 9: RPS Connector’s Pin Layout.

16 15 14 13 12 11 10 9

8 7 6 5 4 3 2 1

Pin 16 is at the connector’s top left, while pin 1 is at its lower right.
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Cables and Loopback Plugs

This section describes how to make cables for connecting the switch’s
interfaces to networks, terminals, and printers. How to make loopback plugs
for testing switch interfaces is also described.

Descriptions of cables and loopback plugs for PIC interfaces can be found in
the Port Interface Card Hardware Reference.

Terminal and Modem Cables
Figure 7 on page 16, and Figure 8 on page 17 show how to wire cables to

connect a standard VT100 compatible terminal, or a modem, to the switch’s
RS-232 Terminal Port.

Figure 7: Pin wiring diagram for a standard DB9 male to female terminal cable.

DB9 Male DB9 Female
(to switch/DCE) (to PC/terminal/DTE)
Not connected 1 1 (DCD)
Lo 2 2 RXD)
~ (RXD) 3 3 (TXD)
~ (CD) 4 4 (DTR)
(GND) 5 5 (GND)
- (DTR) 6 6 (DSR)
~ (CTS) 7 7 (RTS)
~ [RTS) 8 8 (CTS)
~ (RING) 9 9 (RING)
Pin 1 Pin 5 Pin & Pin 1
—t Cable
o5 o
\
Pin Pin 9 Pin 9 Pin 6
DB9 Male Pin View DB9 Female Pin View
Notes:
(1) — Output from switch; — Input to switch.
(2) Cable version 1.0.
DBYMDB9Fsw

C613-03025-00 REV B
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Figure 8: Pin wiring diagram for a DCE RS-232 Terminal Port (DB9 female

connector) male to male modem cable.

DB9 Male
(to switch/DCE)

DB9 Male
(to modem/DCE)

DB9 Male Pin View

Notes:
1) - Output from switch;  Input fo switch
2) Cable version 1.0.

Not connected 1
- (TXD) 2 3 (TXD)
— (RXD) 3 2 (RXD)
~ (CD) 4 1 (DCD)
(GND) 5 5 (GND)
- (DTR) 6 4 (DTR)
~ (CTS) 7 8 (CTS)
- (RTS) 8 7 (RTS)
(RING) 9 9
6 Not connected
Pin 1 Pin 5 Pin 5 Pin 1
| W Cable | W
(@] (@]
o =) (25 o
Pin 6 Pin 9 Pin 9 Pin 6

DB9 Male Pin View

DBYMDBYFsw

The switch’s RS-232 Terminal Port has a DCE female socket. This allows the use

of a straight-through cable when connecting the switch to a terminal or PC.

Output from the SHOW ASYN command will, however, still have a DTE
perspective. The internal DTE pin roles are listed in Table 10 on page 17.

Table 10: Internal DTE pin roles.

Pin Role
2 TXD
3 RXD
4 CcDh
5 GND
6 DTR
7 CTS
8 RTS
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Loopback Plugs for Testing Switch Interfaces

Loopback plugs are used in conjunction with the Test Facility software to test
the physical interfaces on the switch and some PICs (see the “Test Facility”
section beginning on page 18 of this Reference, and the Test Facility chapter of
the AR800 Series Switching Router Software Reference). The purpose of a loopback
plug is to connect the output pins on the interface to the input pins so that any
data transmitted over the interface is looped back (hence loopback plug) and
received at the same interface.

On interfaces with control signals, these are also looped back. The data
received on the interface is compared with the data transmitted to determine
whether or not the interface is functioning correctly. In order to produce a
comprehensive test report for the interface being tested, most tests performed
by the Test Facility require a loopback plug to be inserted.

Some interfaces (e.g. synchronous ports) require a specially built external
testing device (available from your Authorised Allied Telesyn distributor or

reseller) to be used in conjunction with the Test Facility.

Figure 9: Ethernet twisted pair (TP) loopback plug.

Twisted Pair (TP) Loopback Plug (RJ45 connector)

87 654321

X+ 1 I I I I I I I I
TX- 2 3—
RX+ 3
4 Switch end view
5 of p|ug
RX- 6 ——
7
8 | I

RTPLOOPsw

Test Facility

This section introduces the Test Facility. The Test Facility is built into all AR800
Series Switch software. For detailed information on operating the Test Facility,
see the Test Facility chapter of the ARS00 Series Switching Router Software
Reference.

The Test Facility is designed to test the switch’s physical interfaces. Testing
should not be performed while the switch is operational as the presence of a
loopback plug may cause feedback of network traffic. Also, any interfaces
being tested are dedicated to the Test Facility. The Test Facility can be thought
of as a specialised interface module like PPP or Frame Relay.

The Test Facility will not test Ethernet interfaces on AT-AR026 PICs.

ARB800 Series switches and their expansion options support a wide range of
interface types, including Ethernet, asynchronous, synchronous, Basic Rate
ISDN and Primary Rate ISDN. Each interface type (except Ethernet interfaces
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on the AT-AR026) can be tested independently using the Test Facility software.
The following examples show how to test specific interfaces.

Test results are displayed with the command:
SHOW TEST
which produces a display like that shown in Figure 10 on page 19.

Figure 10: Example output from the SHOW TEST command.

Board ID Bay Board Name Rev Serial nunber
Base 115 AT- RP24 AR 824 ML-1 6845425
Upl i nk 88 1 AT- A35SX/ SC-00 P1-0 14269019
Dur ati on Details
Interface State Resul t Type (mnutes) Data( %K ) Control

Ethernet LAN Port Tests

A loopback plug is required to run the first part of the Ethernet LAN test. See
“Loopback Plugs for Testing Switch Interfaces” on page 18 for details of how to
make a loopback plug. To start an Ethernet interface test, use the command:

ENABLE TEST | NT=PCRTn

where 1 is the Ethernet interface number. The test will run for 4 minutes. Use
the SHOW TEST command to observe the test progress.
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Other Interface Tests

Refer to the Test Facility of the AR800 Series Switching Router Software Reference
for information on testing other interfaces.

If a test fails, please contact your Authorised Allied Telesyn distributor or reseller.

Troubleshooting

This section provides information on how to detect and resolve problems with
ARB800 Series Switches and their expansion options.

Other sources of useful troubleshooting information are:

m  www.alliedtelesyn.co.nz/support/ar800/.

m  The ARS00 Series Switching Router Software Reference.

Performing the following tasks will eliminate the most common faults.
1. Make sure the power cord is securely connected.
2. Check that the power supply voltage is stable.

3. Check that the correct data cables are being used and that their connections
are secure.

4. Make sure that other network devices are working properly.

5. Use the SHOW INSTALL command to check that the latest software release
is loaded. See the AR800 Series Switching Router Software Reference for more
information about obtaining the latest software release.

6. If the switch is malfunctioning, reboot it by pressing the recessed Reset
button or entering the command RESTART REBOOT. Alternatively, power
OFF and ON the switch by disconnecting and reconnecting the main power
supply (including, if connected, the RPS power).

LEDs and What They Mean

The following tables outline how the Switch, Uplink Module and PIC LEDs
report faults and operational activities. Uplink Modules, NSMs, and PICs are
expansion options and can be purchased separately. Contact an Authorised
Allied Telesyn distributer or reseller, or visit www.alliedtelesyn.co.nz/
support/ar800/ for more information on purchasing expansion options.
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Switch LEDs

These LEDs are on the front or rear panels of AR800 Series switches.

Table 11: System LEDs (Common to all AR800 Series switch models).

LED State Function
Power Green The switch is receiving power and the
voltage is within the acceptable range
Fault Red The switch or management software is
malfunctioning
1 flash A switch fan has failed. (The LEDs will
not indicate an RPS fan failure.)
3 flashes If an RPS is connected, the switch’s
PSU (Power Supply Unit) has failed
4 flashes If RPS monitoring is enabled, the RPS
PSU has failed
5 flashes If RPS monitoring is enabled, an RPS is
not connected or is not operational
RPS! (Redundant Green An RPS is connected to the switch
Power Supply)
In use (Rear panel) Green AnNSM is installed, is receiving power,
and is operational. The NSM and its
PICs are not ready for hot swap
Off No NSM is installed, or the NSM is not
installed correctly (the switch unit has
not recognised the NSM)
Swap (Rear panel) Green The NSM and its PICs are ready to be
hot swapped
Off The Hot Swap button must be pressed

before the NSM or PICs can be hot
swapped, or the software release does
not support hot swapping2

1. DC models of the AR80O0 Series Switching Router do not have an RPS connector and the RPS LED will

not function.

2. Hot swapping is supported by Software Release 2.3.1 or later. AT-AR021 (S) BRI-S/T, AT-AR021 (U)
BRI-U, AT-AR022 ETH, AT-AR023 SYN, and AT-AR026 4ETH PICs can be hot swapped.
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These LEDs are on the front panel of the respective AR800 Series switch model.

Table 12: Switch Port LEDs (AR824).

LED State Function
/A Green A 100 Mbps link is open
(Link/Activity)

Flashing Green

100 Mbps activity is occurring

Amber

A 10 Mbps link is open

Flashing Amber

10 Mbps activity is occurring

D/C Green

The port is operating at full-duplex

(Duplex/Collision) Amber

The port is operating at half-duplex

Flashing Amber

Collisions are occurring on the line

Table 13: Switch Port LEDs (AR816F-FX/SC and AR816F-FX/MT-RJ).

LED State Function
/A Green A 100 Mbps link is open
(Link/Activity)

Flashing Green

100 Mbps activity is occurring

D/C Green

The port is operating at full-duplex

(Duplex/Collision) Amber

The port is operating at half-duplex

Flashing Amber

Collisions are occurring on the line

Uplink Module LEDs

The following tables may be helpful when diagnosing possible operational
faults. These LEDs are located on the face-plate of the respective Uplink
Module model. Uplink Modules are expansion options and must be purchased

separately.

AT-A40 and AT-A41 Uplink Modules can not be installed in AR800 Series

Modular Switching Routers.

Table 14: Uplink Module LEDs (AT-A35-SX/SC and AT-A35-LX/SC).

LED State Function
Link Green The port is receiving light
Off No link is present
Activity Flashing Amber Frames are being transmitted or received
through the port
Off No activity is occurring
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Table 15: Uplink Module LEDs (AT-A39-T/RJ-45).

LED State Function
Full Dup/Half Green The port is operating at full-duplex
Dup/Col
Amber The port is operating at half-duplex
Flashing amber Collisions are occurring
Off No link is present
Activity Green A 1000 Mbps link is open

Flashing green

1000 Mbps activity is occurring

Amber! A 10/100 Mbps link is open

Flashing Amber’ 10/100 Mbps activity is occurring

Off No link is present

1. Operation is fixed at 1000 Mbps when the AT-A39/T Uplink Module is installed in an AR800 Modular

Switching Router.

Table: 16 AT-A42/GBIC LEDs.

LED State Function
/A Green A 1000 Mbps link is open
Link/Activit . L .
INWACIVIY Flashing green 1000 Mbps activity is occurring
Flashing amber A TX fault has occurred
(and GBIC LED is Off)
Off No link is present
GBIC Green The switch has recognised the GBIC,
the GBIC is a valid model
Green The port is operating at full-duplex
(and /A LED is flashing
GREEN)
Amber The switch has not recognised the
(and /A LED is OFF) GBIC, the GBIC is not a valid model
Amber The port is operating at half-duplex
(and /A LED is flashing
GREEN)
Flashing amber Collisions are occurring
(and /A LED is flashing
GREEN)
Off No GBIC is installed, or a TX fault has
occurred
Both LEDs Slow alternate flashingof ~ The switch has not recognised the

/A and GBIC LED, amber

GBIC, or the GBIC is not a valid model
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NSM LEDs

NSMs are expansion options and must be purchased separately.

The AT-AR040 NSM unit has no independent LEDs. See Table 11 on page 21 for
information about related LEDs found on the base-unit switch or router.

These LEDs are located on the face-plates of AT-AR041 and AT-AR(042 NSMs.

Table 17: AT-AR041 and AT-AR042 LEDs.

LED State

Function

Active Green

Lit when the BRI has successfully
completed the exchange of INFO 1 and
INFO 2 signals, and INFO 3 and INFO 4
signals are present on the link. This
means that the ISDN interface is correctly
connected to a working NT device.

Off

No BRI activity is occurring.

Data Amber

Pulses when HDLC packets are being
exchanged between the switch or router
and the ISDN switch over the B and D
channels.

Off

No data exchange is occurring.

PIC LEDs

PICs are expansion options and must be purchased separately. PICs are
expansion options and must be purchased separately. They can only be used if
a suitable NSM is installed in the switch (such as an AT-AR040).

These LEDs are located on the face-plate of the respective PIC.

Table 18: PIC LEDs (AT-AR020 PRI E1/T1).

LED Function

D Data [ISDN mode only] Lit when HDLC packets are being exchanged between
the switch and the ISDN switch over the D (signalling) channel.

B Data Lit when HDLC packets are being exchanged between the switch and
another end system device (normally another switch or router) over any

of the B (data) channels.

Active Lit whenever operational (i.e., no RAI or AlS) frames are being received

from another source.

NT [ISDN mode only] Lit when the PRI1 is operating in NT mode. This LED
should not be lit during normal operation.
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Table 19: PIC LEDs (AT-AR021(S) BRI-S/T).
LED Function
B1, B2 For on-demand ISDN, lit when there is a call up over the respective B
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channel and flashing when data is being exchanged.

For permanent circuits, lit when HDLC packets are being exchanged
between the switch or router and another TE end system device (normally
another switch or router) over the respective B (data) channel.

Active Lit when the BRI has successfully completed the exchange of INFO 1 and
INFO 2 signals, and INFO 3 and INFO 4 signals are present on the link. This
means that the ISDN interface is correctly connected to a working NT
device.

D Lit when HDLC packets are being exchanged between the switch and the
ISDN switch over the D (signalling) channel.

Table 20: PIC LEDS (AT-AR021(U) BRI-U).

LED Function

B1, B2 Lit when HDLC packets are being exchanged between the switch and
another TE end system device (normally another switch or router) over
the respective B (data) channel.

For ISDN, lit when there is a call up over the respective B channel and
flashing when data is being exchanged.

Active Lit when the U interface is in the Activated state (i.e., it is fully operational
at layer 1).
D Lit when HDLC packets are being exchanged between the switch and the

ISDN switch over the D (signalling) channel.

Table 21: PIC LEDs (AT-AR023 SYN).

LED Function
Tx Lit when data is being transmitted over the synchronous interface.
Rx Lit when data is being received over the synchronous interface.

Table 22: AT-AR026 4ETH PIC LED functions (Two LEDs per port).

LED Function

Left Lit when the port is operating at 100Mbps and full duplex.

Right  Lit when a link has been established. Flashing when data is being transmitted
through the port.

The AT-AR024 ASYN4 PIC does not have LEDs.
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En

Some common problems and how to solve them

Link/Activity LED on Any Port is Off

This can indicate:
m A loose data cable.

m  The device at the other end of the connection is not working properly or is
turned off.

m  The data cable is not wired correctly.

m  The network administrator has manually disabled the port through the
software.

m  The port’s selected transmission mode does not match that of the attached
device.

Perform the following steps in sequence:

1. Make sure the data cable connections are secure.

2.  Make sure the device at the other end of the connection is switched on and
working properly.

3. Check that the data cable is wired correctly.

4. If you can, log in and check the port status. See “To log In” on page 8 for
more information on how to log in.

5. If the port is Enabled, make sure the transmission speed matches that of the
connected device (auto-negotiating, full or half-duplex).

If the port is disabled, someone has used the software to manually disable it. You should
find out why the port was disabled before enabling it.

Power LED is OFF

This can indicate:
m A loose power cord.

m A power supply failure.

Perform the following steps in sequence:

1. Check that the power cord connections are secure.

2. Check that all switches and circuit protection devices are in the ON position.

3. Ensure that the supply voltage is within the operational range (110/240
VAC 50/60 Hz for AC models, 39-60 V DC for DC models).

Fault LED ison

This can indicate:

m  There is a problem with the switch or RPS PSU.

m  The switch or management software is malfunctioning.

m A hardware fault is preventing switch start-up.
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Perform the following steps in sequence:

1. Check Table 11 on page 21 for descriptions and explanations of LED
flashing sequences.

2. Reset the switch by pressing the recessed RESET button on the front panel.

3. If you were attempting to download software or manage the switch via the
RS-232 terminal Port, check that connections between the Terminal Port and
local terminal or PC are secure.

If you cannot access the switch’s software because of a faulty RS-232
Terminal Port connection, you can still manage the switch via Telnet or
SNMP until the problem is fixed.

4. Unplug the switch and then plug it in again. If present, you will also have
to disconnect and reconnect the RPS unit.

5. Download the latest software release. See the AR800 Series Switching Router
Software Reference for more information on how to obtain the latest software
release.

Expansion Options

This section provides an overview of the expansion options for AR800 Series
switches. The following expansion options were available when this Reference
was written. See your Authorised Allied Telesyn distributer or reseller, or visit
www.alliedtelesyn.co.nz/support/ar800/ to see if any new options are
available.

Uplink Modules

Uplink Modules increase switching capacity by providing a maximum of two
extra ports and by allowing switches to be linked together in stacks. For the
ARB800 Series, Uplink Modules with gigabit capacity are available.

Uplink Modules in the following list are the only modules that should be
installed into AR800 Series switches. Check with your Authorised Allied
Telesyn distributor or reseller, or visit www.alliedtelesyn.co.nz/support/
ar800/ to see if any new Uplink Module models are available.

Uplink Modules currently available for AR800s include:

m  AT-A35-SX/SC 1-port 1000BASE-SX (SC connector)

m  AT-A35-LX/SC 1-port 1000BASE-LX (SC connector)

m  AT-A39-T/RJ-45 1-port 1000BASE-T (R]-45 copper connector)

m  AT-A42/GBIC 1-port 1000BASE-X (GBIC slot)

For more information on Uplink Modules, contact your Authorised Allied Telesyn
distributor or reseller, or see the Uplink Module Hardware Reference. This and other
documentation can be found on the AR800 Series Documentation and Tools CD-ROM
bundled with your switch, or at www.alliedtelesyn.co.nz/support/ar800/.
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Network Service Modules

The AR824, AR816F/SC, and AR816F/MT include a Network Service Module
(NSM) expansion bay. NSMs slot into a base-unit switch and either directly
provide additional interfaces, or provide multiple slots where additional
interfaces can be added.

Three NSMs are currently available:

m  AT-ARO040 (4 Port Interface Card (PIC) slots)

m  AT-ARO041 (8 BRIS/T WAN Ports)

=  AT-AR042 (4 BRIS/T WAN Ports)

For more information on NSMs, contact your Authorised Allied Telesyn distributor or
reseller, or see the Network Service Module Hardware Reference. This and other
documentation can be found on the CD-ROM bundled with your switch, or at
www.alliedtelesyn.co.nz/support/ar800/.

Port Interface Cards (PICs)

PICs provide a cost effective and flexible mechanism for adding new or
additional WAN network interfaces to the switch. By adding or changing PICs,
the switch’s network interface capabilities can be upgraded without replacing
the switch itself. A PIC can provide additional network interfaces, or can be
replaced with a different PIC to provide alternative interface types.

An AT-AR040 NSM must be installed before PICs can be used with AR800
Series switches.

The following PICs can be used in the AT-AR040 NSM when it is installed in a
ARB800 Series switch:

e AT-AR020 PRI E1/T1

e AT-AR021 (S) BRI-S/T*

e AT-AR021 (U) BRI-U*

e AT-AR023 SYN*

e AT-AR024 ASYN4

e AT-AR026 4ETH*
* These PICs can be hot swapped if the host AR800 is running Software Release

2.3.1 or later. See the Port Interface Card Hardware Reference for more
information.

For more information on PICs, contact your Authorised Allied Telesyn distributor or
reseller, or see the Port Interface Card Hardware Reference. This and other
documentation can be found on the CD-ROM bundled with your switch, or at
www.alliedtelesyn.co.nz/support/ar800/.
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VAN

PCl Accelerator Cards (PACs)

PCI Accelerator Cards (PACs) provide additional processing features or
performance, but do not add extra physical interfaces to the switch. A PAC can
be installed in the dedicated PAC slot on all AR800 switches.

PACs should only be installed by authorised service personnel. Unauthorised
opening of the switch’s lid may cause danger of injury from electric shock,
damage to the switch, and invalidation of the product warranty.

Two PACs are available:
= AT-AR060 EPAC, Encryption PAC.
m  AT-AR061 ECPAC, Encryption/Compression PAC.

See “Restricted Procedures” on page 35 for more information on the PAC
installation procedure.

How PACs work

PACs provide AR800 switches with high performance hardware-based
encryption and/or compression services. PACs have a DMA slave processor,
which operates independently of the base system. This processor is responsible
for the transfer of data between the base system and the PAC, and the control
of local high speed encryption and compression data processing devices.

This architecture allows data encoding to be performed off-line without
involving the base switch processor, thereby maximising PAC performance

while at the same time minimising impact on the switch.

The PAC is a single card. Figure 11 on page 29 shows the layout of the board for
an AT-AR061 ECPAC.

Figure 11: Location of main components on the AT-AR061 ECPAC card.

PAC Connector
l Hole for PAC fastner

Y

Holes for PAC fasteners
PAC
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Compression

PAC-based compression has the following features:

m  Local 32-bit processor for high speed control and data transfer.

m  Dedicated high performance 32-bit compression hardware.

m  High compression ratio Lempel-Ziv algorithm in hardware.

m 2 MBytes of history memory.

m  Support for up to 127 compression channels.

Compression and decompression operations are performed by a 32-bit data
compression coprocessor specifically designed for high-performance Lempel-
Ziv compression applications. The 2 MBytes of history memory allows up to
127 individual data links to use compression concurrently, enabling PACs to
provide compression for complicated network architectures. Figure 12 on

page 30 shows typical compression ratios achieved by a PAC for a
representative set of file types.

Figure 12: Typical hardware compression ratios by file type.

Compression Ratio
7

Font Program Window Text  Object Spread Csource EPS  Bitmap  TIFF
sheet

File Type

CMPRATIO

Encryption

PAC-based encryption has the following features:

m  Local 32-bit processor for high speed control and data transfer.

m  Dedicated high performance 32-bit Data Encryption Standard — DES and
Triple DES (3DES) — hardware.

PAC DES and triple DES encryption are based on a fast 32-bit device that
complies with FIPS PUB 46, ISO DEA-1 and ANSI X3.92 standards.
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Dual Mode

Throughput of an encrypted link can be dramatically increased by using data
compression. To support this, ECPACs support both encryption and
compression, providing a dual mode that allows combined compression and
encryption operations. So that the compression phase will have the best
opportunity at finding non-random data, compression occurs before
encryption, in the order:

conpression - encryption -// - decryption - deconpression

Adding compression to an encrypted link increases line throughput. Once
compression has been carried out there is less data requiring encryption,
passing back to the base system, and transferring across the network, so less
base system bus and network link bandwidth is required for a given amount of
data. This results in the dual operation being very effective where encryption is
required.

Port, Connector, and Cable Combinations

Table 23: Cable guidelines.

Model Port Type Connector Type Cable Type1 Maximum Cable Length
AR824 10BASE-T/ RJ-45 10BASE-T Category 3 or 100m (328ft)
T00BASE-TX better
100BASE-T Category 5or  100m (328ft)
better
AR816F-FX/SC 100BASE-FX SC 50/125 or 62.5/125 Full-duplex 2km (6,600ft)
micron multimode fibre Half-duplex 412m
(1360ft)
AR816F-FX/MT-R)  100BASE-FX MT-RJ 50/125 or 62.5/125 Full-duplex 2km (6,600ft)

micron multimode fibre

Half-duplex 412m
(1360ft)

1. Refer to the IEEE 802.3 standards for further cable information.
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Using Windows Terminal and Windows

Hyperterminal

You can use a PC running terminal emulation software as the manager console,
instead of a terminal. There are many terminal emulation applications
available for the PC, but the most readily available are the Terminal and
HyperTerminal applications included in Microsoft Windows 95, 98, 2000, and
Windows NT 4.0. In standard Windows installations, HyperTerminal is located
in the Start > Programs > Accessories menu.

The key to successful use of terminal emulation software with the switch is to
configure the software and switch with matching communications parameters.
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The following procedures describe how to configure Windows Terminal and
HyperTerminal for the default RS-232 Terminal Port settings on the switch, but
the same principles apply to other terminal emulation programs.

3’ To configure Windows HyperTerminal for Windows 95, 98, 2000, & NT 4.0.
&

’ 1. In Windows, select:

1
&2 .

e Double-click the Hypertrm.exe icon.

Programs > Accessories > HyperTerminal.

2. In the Connection Description dialog box:
* Enter a name for the connection (e.g., AR824)
¢ Select an icon from the scrolling list.
e C(Click “OK”.

3. In the Phone Number dialog box:

From the “Connect using:” drop-down list, select:

¢ “Direct to Com n” Where “COM n” is the COM port on the PC used to
connect to the switch.

e C(Click “OK".

Phone Number E

% AR800

Enter details for the phone number that you want to dial:

Country code: Ir“iew Zealand [64] j

Area code: I%

Phone number: I

Connect using:  [{ni= eyl

oK I Cancel

4. Inthe COMn Properties dialog box, set:
e Bits per second: 9600.
¢ Data bits: 8.
e Parity: None.
e Stop bits: 1.
¢ Flow control: Hardware.

e Click “OK”.
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COM1 Properties EHE

Port Settings |

Bits per zecond: lh
Data bits: IS vl
Parity: INone vl

Stop bits: lﬁ

FElow contral: lm

Advanced... | Bestore Defaults |

Cancel | Aol |

5. From the File menu, select:
e “Properties”
In the Connection Properties dialog box, click the Settings tab and set:
e “Function, arrow, and ctrl keys act as” to “Terminal keys”

e  “Emulation” to VT100.

AR800 Properties HE3

Phone Mumber  Settings I

Function, arrow, and ctil keys act as
’7 & Teminal keys C Windows keys

Emulation:

SARTCOMM - |  7orvineiSetp. |

Backscroll buffer lines:
|500 =

[ Beep three times when connecting or disconnecting

ASCI Setup.... |
0K I Cancel |

6. Click "ASCII Setup” to display the ASCII Setup dialog box. Uncheck:
e “Echo typed characters locally”.
e “Append line feeds to incoming line ends”.
Set other parameters as required.

e Click “OK” twice to close all dialog boxes.
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ASCIl Setup EHE

— ASCI Sending

[ Send line ends with line feeds

" Echotyped characters locally

Line delay: ID milliseconds.
Character delay: ID milliseconds.

— ASCI Receiving

[~ Append line feeds to incoming line ends
™ Eorce incoming data to 7-hit ASCH

¥ Wrap lines that exceed terminal width

Cancel

7. Save the current session. From the File menu, select:
e “Save”.

This creates a connection icon with the name you assigned in the
HyperTerminal group. To use the configuration:

*  Double-click the connection icon in the HyperTerminal group.
When the HyperTerminal window appears, press:
e [Enter] a couple of times.

The switch’s log in prompt will appear.

Restricted Procedures

This section contains procedures that should only be performed by authorised
service personnel. Unauthorised use of procedures in this section may cause
danger of injury from electric shock, damage to the switching router, and
invalidation of the product warranty.

If you would like to know more about the procedures outlined in this section,
please contact your authorised Allied Telesyn distributor or reseller.

Diagnostics

The switch software includes a set of diagnostic programs. These programs
perform basic level checks of all system components. They do not run in
conjunction with the normal operating code, and require that the system be
totally dedicated to their use. A detailed knowledge of the way the switch
hardware functions is necessary if diagnostics are to be used effectively.

I@: The switch will not perform switching operations if diagnostics are running.

I@: Diagnostics will not perform checks on AT-AR026 PICs.
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are designed to be run by service personnel only. For more information, contact

Q This section is not intended as a guide to the diagnostics software. Diagnostics
your Authorised Allied Telesyn distributor or reseller.

3’ To enable diagnostics mode:
¢

’ 1. Connect a terminal to the RS-232 Terminal Port.

1’ > . . :

& Using an RS-232 DB9 straight-through cable, connect a terminal to the
RS-232 Terminal Port on the switch.

Set the terminal communication parameters to the following:

e Baud rate: 9600

¢ Data bits: 8

e Parity: None

e Stop bits: 1

¢ Flow control: Hardware

2. Restart the switch.

Restart the switch, either by using a pen or pencil to operate the recessed
reset button on the front panel, or by using the terminal to log in and enter
the command:

RESTART REBOOT

See “To log In” on page 8 for more information on how to log in.

3. Enable diagnostics mode during start-up.
During the switch start-up process, at the prompt:
For ce EPROM downl oad (Y)?

press [Ctrl/D] on the terminal to enter diagnostics mode. A banner page will
be displayed on the terminal (Figure 13 on page 36). This can be used to
check that the terminal is correctly connected.

Figure 13: AR800 Series switch diagnostics banner page.

* * * [jagnostic Mdde * * *
version 16-Mar-98

Mai n Menu:
0. Restart
Ful | RAM test
ROM checksum t est
Ful | FLASH test
Totally Erase FLASH
5. Battery backed RAMtest
Enter selection ==>

PR

To run a diagnostic program, enter the corresponding letter or number (or key).
There are several sub-menus to cover all the available options. Table 24 on
page 36 lists the control keys for diagnostic operations.
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Table 24: Basic commands for running the diagnostics.

Key Function
Q Quits any running tests and displays the banner page.
S Prints a summary of test results so far.

A reasonable understanding of the system’s structure is needed to operate
diagnostics and interpret the results.

To restore the switch to normal operation, use a pen or pencil to operate the
recessed reset button on the front panel, or press “0” (zero) to restart.

Installing a PAC
PACs can be installed in all AR800 Series Modular Switching routers.

PACs should only be installed by authorised service personnel. Unauthorised
opening of the switch’s lid may cause danger of injury from electric shock,
damage to the switch, and invalidation of the product warranty.

Before installing a PAC:

1. Check that you have the correct tools and equipment.

You will need a medium-sized posidrive screwdriver.

2. Avoid injury by working in a safe environment.

The workspace should be free of hazards, and there should be sufficient
room to lay out the switch, PAC, and tools.

3. Unpack the PAC in an antistatic environment.

Do not attempt to install any hardware without observing correct antistatic
procedures. Failure to do so may damage the switch or PAC. If you are unsure
what the ‘correct’ procedures are, contact your authorised Allied Telesyn
distributor or reseller.

To install a PAC:
1. If fitted, disconnect the switch’s redundant power supply.

2. Disconnect the mains power cord.

Before removing the switch’s lid, the power cord and, if connected, RPS power
cord should be disconnected to reduce risk of electrical shock.

3. Remove all interface cables.
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Remove the switch’s lid.

The switch may need to be removed from any rack mounting system
before its lid can be removed.

Using a posidrive screwdriver, remove the 12 screws that secure the
switch’s lid. There are 5 screws located in countersunk holes on each side
of the lid, and 2 screws at the rear.

If not already installed, install the PAC pillars.

Each PAC is shipped with six pillars (three plastic and three metal). If
installing the PAC in an AR824, use the plastic pillars. If installing the PAC
in any other AR800 Series model, use the metal pillars.

Carefully screw the appropriate pillars into the three threaded pillar
mounts on the switch’s base board. The pillars should be firm but not
overtight.

Figure on page 37 shows the PAC pillar mounts on an AR800 base board.

Figure 14: Location of PAC slot and pillar mounts on an AR800 base board.

PAC slot
) °o 1
o 0.7
S W
A I8 i
. :
'D R 3] : :I
Boot EPROMs 7
0 o o L

Fan - HH

PAC pillar mounts

8PACslot

Insert the PAC.

Position the PAC over the PAC slot on the switch base card, making sure
that the support pillars located on the switch base card are aligned with the
holes provided on the PAC. This ensures that the connector on the PAC is
correctly aligned with the slot on the switch base card.

Press the connector firmly into place. Secure the PAC to its three pillars
using the fasteners supplied.

Figure on page 37 shows the PAC slot on an AR800 base board.

Replace the switch’s lid and the power cord.

Secure the switch’s lid. If you disconnected an RPS supply, reconnect it
now.

Reconnect any interface cables that you disconnected to install the PAC.

The PAC is now ready to test.
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Testing a PAC

There are several ways to check that the PAC is installed and operating
correctly. First, check that the switch has recognised the card. Turn on the
switch and enter the command:

SHOW SYSTEM

to display the system information shown in Figure 15 on page 39.

The first part of the display shows details of the cards installed in the switch.
There should be at least two entries, one for the switch base card and one for
the PAC. Both the serial number and the part name should be displayed.

If there is no entry for the PAC then the switch’s boot process has not correctly
detected the PAC’s presence. The most likely cause is that the PAC is not
correctly plugged into the slot on the switch’s base board. Repeat the
installation process, paying particular attention to Step 6.

Use the SHOW SYSTEM command again, and if the display is still not correct,
contact your authorised Allied Telesyn distributor or reseller.

If you have any difficulty with the PAC at any time, contact your authorised Allied
Telesyn distributor or reseller and quote the serial numbers of both the base card on the
switch and the PAC. The serial numbers and revision details can be read using the
SHOW SYSTEM command. It’s a good idea to record this information for later
reference.
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Figure 15: Example output from the SHOW SYSTEM command for an AR800 switch with an AT-AR061 ECPAC
installed.

Switch System Status Ti me 00:23: 04 Date

15- Jun- 2001.

Board I D Bay Board Name Rev Serial nunber
Base 86 AT- AR824 M2-1 46690596

NSM 4PIC 87 AT- AR040- 00 NSM 4PI C M3-3 6845206

PIC 38 1 AT-AR023-00 PIC Sync ML-1 8618528

PAC 153 AR061 ECPAC P1-16 6844578
Menory - DRAM : 32768 kB FLASH : 6144 kB

SysDescription
Allied Tel esyn AT- AR824 version 2.2.2-00 18-May-2001
SysCont act

SyslLocation
SysNane

SysDi st Nane

SysUpTi e

102398 ( 00:17:03 )

Software Version: 2.2.2-00 18-May-2001
Rel ease Version : 2.2.2-00 18- May-2001

Rel ease built : Jun 15 2001 at 05:03:04

Patch Installed : NONE

Territory . europe

Help File : help.hlp

Mai n PSU . On Mai n Fan . On
RPS Moni t or D Of

Boot configuration file: Not set
Current configuration: None
Security Mde : Disabled

War ni ng (248283): No patches found.

Next, check the PAC’s status using the command:
SHOW LOG

to display a log of PAC events. A typical display is shown in Figure 16 on
page 40.
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Figure 16: Example output from the SHOW LOG command for an AR800 switch with an AT-AR061 ECPAC card

installed.
Dat e/ Ti ne Mod Type SType Message
15 00: 05: 50 ENCO ENCO PAC 7751 Found. Initialisation started
15 00: 05: 50 ENCO ENCO PAC 7751 Initialisation Successful
15 00: 05: 50 SYS REST NORM Switch startup, ver 2.2.2-00, 18-Muy-2001,
Cl ock
Log: 00:04:40 on 15-Jun-2001
15 00: 05: 53 USER USER 00011 manager login failed on portO
15 00: 05: 58 USER USER LON rmanager |ogin on portO
15 00: 05: 59 CH MG WARN No patches found

If any PAC tests fail, check that the PAC is correctly installed in its slot and repeat the
tests. Contact your authorised Allied Telesyn distributor or reseller if the PAC does not
operate correctly.

Once the PAC is operating, its functionality can be tested either by using the
Test Facility software, which is built into the switch, or by configuring a
module to use the PAC. For more information about configuring interfaces, see
the “Compression and Encryption Services” chapter of your switch’s Software
Reference.

Using the Test Facility to Verify Operation

The built-in Test Facility software is the easiest way to verify a PAC’s operation.

See the Test Facility chapter of your switch’s Software Reference for more information
about the Test Facility.

To run the Test Facility for a PAC, use the command:

ENABLE TEST | NTERFACE=PAC

The test will run for 4 minutes. To view the results of the test at any time, use
the command:

SHOW TEST

Figure 17 on page 41 shows a typical output. The status of the test will be
shown in the right-hand column. For further information on the meanings of
the other figures, see the “Test Facility” chapter of your switch’s Software
Reference.
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Figure 17: Example output from the SHOW TEST command for an AR800 switch with an AT-AR061 ECPAC

installed.

Board ID Bay Board Name Rev Serial nunber

Base 86 AT- AR824 M2-1 46690596

NSM 4PI C 87 AT- AR040- 00 NSM 4PI C MB-3 6845206

PI C 38 1 AT-AR023-00 PIC Sync ML-1 8618528

PAC 153 AR061 ECPAC P1-16 6844578

Duration Details

Interface State Resul t Type (mnutes) Data( %K)

Cont r ol
portl no test - - - - - -
port2 no test - - - - - -
port3 no test - - - - - -
port4 no test - - - - - -
port5 no test - - - - - -
port6 no test - - - - - -
port?7 no test - - - - - -
port8 no test - - - - - -
port9 no test - - - - - -
port10 no test - - - - - -
port1ll no test - - - - - -
portl2 no test - - - - - -
port1l3 no test - - - - - -
portl1l4 no test - - - - - -
portl5 no test - - - - - -
portl1l6 no test - - - - - -
portl7 no test - - - - - -
port1l8 no test - - - - - -
portl19 no test - - - - - -
port20 no test - - - - - -
port21 no test - - - - - -
port22 no test - - - - - -
port23 no test - - - - - -
port24 no test - - - - - -
synO no test - - - - - -
asynO no test - - - - - -
enco0 testing wait 4 mnutes DES <1 good( 100. 0) -
encol testing wait 4 mnutes STAC <1 good( 100. 0) -
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If you are unsure about running the Test Facility, or have difficulty evaluating
the results then contact your authorised Allied Telesyn distributor or reseller.

Replacing Boot EPROMs

ARB800 Series switches have two 512 kByte boot EPROMs. The boot EPROMs
contain bootstrap code, which loads the main code from a software release file
in FLASH memory. In rare circumstances the boot EPROM(s) may need to be

changed.
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Boot EPROMSs should not need to be replaced, except in rare circumstances.
Contact your Authorised Allied Telesyn distributor or reseller before replacing
any boot EPROMs.

To change the boot EPROMs:

1. Check that you have the correct tools and equipment available.

You will need a medium sized posidrive screwdriver and an EPROM
extraction tool (or a small flat-bladed screwdriver). In addition, adequate
antistatic precautions must be used.

EPROMSs, like most electronic equipment, are highly sensitive to electrostatic
damage. This can be particularly acute in the dry atmosphere normally
associated with computer rooms and typical offices. Before commencing work,
ensure that you have used an approved antistatic wrist strap to discharge any
buildup of static electricity. Wear the strap at all times during the following
procedure.

2. Avoid injury by working in a safe environment.

The workspace should be free of hazards, and there should be sufficient
room to lay out the switch, the EPROM, and the tools.

3. Disconnect the mains power cord.

4. If fitted, disconnect the redundant power supply.

Do not take risks with mains or backup electricity. Do not attempt to remove
the lid of the switch unless all power cords have been disconnected from the
switch.

5. Remove the switch’s lid.

Using a posidrive screwdriver, remove the 12 screws that secure the
switch’s lid. There are 5 screws located in countersunk holes on each side
of the lid, and 2 screws at the rear. The switch may need to be removed
from any rack mounting system before its lid can be removed.

6. Remove the existing boot EPROMs.

The boot EPROM(s) should now be visible on the CPU board. Figure 18 on
page 43 shows the location of boot EPROMs on the CPU board. Remove
the boot EPROMSs using the extraction tool. Alternatively, a small flat-
bladed screwdriver can be used. If using a screwdriver, gently lever each
end of a particular boot EPROM a few millimetres at a time until it comes
free.
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Figure 18: EPROM locations.
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7. Insert the new boot EPROMs.

Insert the new boot EPROMSs one at a time, using as a reference the location
number printed on the CPU board (e.g., “0” and “1”) and Figure . Check
that the boot EPROMs are firmly seated.

Install the boot EPROMs the correct way up! Failure to do so will almost certainly
destroy them. The "top” end of the EPROM has a notch. This should be positioned so that
the notched end of the EPROM is orientated as shown in the relevant location diagram.

8. Replace the switch’s lid and power cord.

Replace the lid and secure it with the 12 posidrive screws. Connect the
power cord and (if disconnected in step 4) the RPS.

9. Check that the switch is operating correctly.

Check that the switch boots up correctly. Connect the switch’s RS-232
Terminal Port to a terminal (see page 16 for information on connection
cables) and check the start-up messages. See “Switch Start-up” on page 8
for a list of start-up messages. Verify that the new software version is
installed by typing the command:

SHOW | NSTALL

which will produce a display like that shown in Figure 19 on page 44. The
boot EPROM software release number is shown in the “Default” field.
Check that this is correct.
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Figure 19: Example output from the SHOW INSTALL command.

Install Rel ease Pat ch
Tenporary - -
Preferred flash: | oad\ 86s-210.rez -
Def aul t EPROM ( 86s-2. 1. 0) -

Current install

Install history

No Temporary install selected

Preferred install selected

Preferred rel ease successfully installed

Troubleshooting EPROM Installation

If the switch fails to reboot or functions incorrectly, then the most likely cause is
that there is a problem with the way the boot EPROMs were installed. Repeat
the installation procedure, checking:

¢ That the boot EPROMs are in the correct locations and oriented
correctly (using the relevant location diagram as a guide).

¢ For bent pins. These should be carefully straightened.

If the switch still fails to reboot, replace the new boot EPROMs with the
original set and contact your Authorised Allied Telesyn distributor or reseller.

Contacting Us

With locations covering all of the established markets in North America, Latin
America and Europe, Allied Telesyn provides localized sales and technical
support worldwide. To find our representative nearest you, visit Allied Telesyn
on the web at: iittp://www.alliedtelesyn.con.

C613-03025-00 REV B


http://www.alliedtelesyn.com

	AR800 Series Modular Switching Router Hardware Reference 
	Copyright
	Contents 
	Models Covered By This Reference 
	Why You Should Read This Reference 
	Where To Find More Information 
	Hardware Description 
	Switch Overview 

	AR800 Switch Models 
	AR816F-FX/MT-RJ 
	AR816F-FX/SC 
	AR824 

	Online Documentation 
	To Access Online Documentation 

	AT-TFTP Server 
	Switch Start-up 
	To log In 
	Start-up Procedures 

	Interfaces 
	RS-232 Terminal Port 
	Switch RJ-45 Ports 
	Redundant Power Supply 

	Cables and Loopback Plugs 
	Terminal and Modem Cables 
	Loopback Plugs for Testing Switch Interfaces 

	Test Facility 
	Ethernet LAN Port Tests 
	Other Interface Tests 

	Troubleshooting 
	LEDs and What They Mean 

	Expansion Options 
	Uplink Modules 
	Network Service Modules 
	Port Interface Cards (PICs) 
	PCI Accelerator Cards (PACs) 

	Port, Connector, and Cable Combinations 
	Using Windows Terminal and Windows Hyperterminal 
	Restricted Procedures 
	Diagnostics 
	Installing a PAC 
	Replacing Boot EPROMs 
	Troubleshooting EPROM Installation 

	Contacting Us 




